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The software and any related written materials are copyrighted. Unauthorized copying of the 
written materials of the software is expressly forbidden. The licensee or any person renting or 
using the software and written materials by other terms may be held legally responsible for 
any copyright infringement that is caused or encouraged by failure to abide by terms of this 
license. The licensee may make copies of the software solely for backup purposes. 
 
In no event may the licensee transfer, assign, or otherwise dispose of the software except 
with the written permission of the licensor. 
 
In no event will the licensor be held responsible for any damages arising out of the use or 
inability to use this software. 
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1 Introduction 
________________________________________________ 
 
MALÅ GroundVision is the data acquisition software dedicated to MALÅ 
GPR systems. GroundVision 2.0 can acquire data from the MALÅ ProEx 
and X3M control units with Ethernet communication. As a Windows™ 
based software GroundVision gives you an easy-to-use user interface, file 
management, printing and other key features. Each measurement and 
associated settings are stored in files. Filtering can be performed with the 
measurement or as post-processing. GroundVision software supports both 
GPS logging and multiple markers during measurement. All radargrams 
can be printed as such, or post processed by further software. 
 

                               
 
We at MALÅ Geoscience welcome comments from you concerning your experiences in using 
this equipment, as well as your impressions of this manual. Please take the time to read 
through the assembly instructions carefully and address any questions or suggestions to the 
following: 
 
Main Office:                         North & South America:        China: 
MALÅ Geoscience AB        MALÅ Geoscience USA, Inc.              MALÅ Geoscience CHINA  
Skolgatan 11                         2040 Savage Rd, P.O. Box 80430     Room 2604 Yuan Chen Xing BLDG   
S-930 70 Malå                       Charleston, SC 29416                         No 12 Yu Min Road, Chao Yang Distr. 
                                                                                                            Beijing 100029 
Sweden                                  USA                                                     China           
Phone: +46 953 345 50        Phone: +1-843 852 5021                     Phone: +86 10 822 50728 
Fax: +46 953 345 67        Fax: +1-843 769 7392    Fax: +86 10 822 50815 
 E-mail: sales@malags.com   E-mail: sales.usa@malags.com          E-mail: kong@malags.com 
                    
 
Technical support issues can be sent to: support@malags.com  
Information about the products from MALÅ Geoscience is also available on Internet: 
http://www.malags.com 
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1.1 Installation and Communication 
 
The GroundVision Software is delivered to you on an installation CD. It 
contains a set of program files that will be installed once you run the 
Setup.exe file. The latest version of GroundVision is always available to 
download from the web site http://www.malags.com/ 
 
When you double click on the setup file (either from the installation CD or 
from the downloaded file) you will enter an installation wizard that will guide 
you through the rest of the installation process. 
 
Note! If you are doing an upgrade installation of GroundVision it is 
recommended to uninstall the previous version of GroundVision first. This 
can be done easiest from the Windows Control Panel, Add/Remove 
programs.  
 
System requirements: Windows 95, 98, ME, 2000, NT or XP and Ethernet 
communication. 

 
To make the communication run between the Control unit and the 
computer used, start up Ground Vision and go to the Tools menu -> 
Hardware setup.  
 
In the Hardware Setup window (see Chapter 6.3), the setting on how 
communication is performed between the PC and the control unit is made. 
In the Ethernet interface drop-down-menu the available Ethernet-interfaces 
are seen. Choose the standard, most often a Generic VPN.  
 
The communication between the PC and the ProEx or the X3M control unit 
will work only with Ethernet on wire.  
 

1.2 User interface 
 
The user interface of GroundVision is following the standard of many other 
windows based programs. Printing as well as window managing is quite 
similar and follow standard windows commands. 
 

www.malags.com 
6

http://www.malags.com/


 
Workspace Toolbar Menu Main

 
 
 
Fig. 1.1 GroundVision main window with a radargram opened. 
 

1.2.1 Main Window 
This can also be called the application window. This window holds the 
application’s (GroundVision’s) menu, status bar, toolbar, workspace, and 
the radargram windows. The main window can be minimized, maximized, 
or resized to any size by the user. 
 

1.2.2 Workspace 
One can say that the workspace is the area managed by the user. The 
main window determines the size of the workspace. The user can 
manipulate the radargram and trace view windows size and position inside 
the workspace. 
 

Radargram Workspace Tabs Status Bar 
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1.2.3 Menu 
The content of the menus varies depending on whether a file is open or not 
or if the program is in measuring mode. All choices that are not available 
are grey.  

1.2.4 Toolbar 
The toolbar holds all the buttons. A toolbar button is a “shortcut” to a menu 
command, i.e. every button corresponds to a menu choice. If a button is 
greyed out that menu alternative is not available.  

1.2.5 Radargram 
The radargram is the image generated by the measured radar data. If the 
amount of data is larger than the window size, scrollbars are used to scroll 
the image, both horizontally and vertically. A mouse left click at a certain 
trace in the radargram shows that trace in the trace view. A mouse right 
click shows a popup menu containing the radargram specific commands. 
When the mouse pointer is moved across the radargram the information 
menu shows the actual trace number, sample number, depth/time and 
position/time. 

1.2.6 Trace View 
The trace view displays a single trace, which 
is determined by position of the mouse cursor 
over the radargram. In data collection mode 
the trace window always shows the last 
incoming trace. The trace view is toggled 
On/Off from the keyboard with the F10 key or 
opened by choosing Trace Window under the 
View menu. 
 
When measuring in multi-channel mode with 
the ProEX, there will be one trace view for 
each active channel. 
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1.3 File format 
 
When measuring with GroundVision two files are generated, one data file 
(.rd3) and one header file (.rad). The data file is a 16-bit binary file and 
contains the sample values. The header file is a text file and contains 
measurement specific information. Never edit and save the information in 
the header file that can cause errors in the file information and give corrupt 
data. If files are to be copied to or from another computer or disc it is 
important that both the data file (.rd3) and the header file (.rad) are copied. 
 
GroundVision also generates other file types if save filter settings, palette, 
GPS and markers are enabled. A list of all file types follows: 
 
.rd3 16-bit binary data file 
.rad Header information file 
.cor Coordinate file acquired from a GPS 
.mkn File with markers 1-9 with colour codes and names 
.fil Saved filter parameters 
.pal Saved palette settings 
 
 
Note!  
When working with several antennas and extension modules (the different 
slots) with the ProEx control unit, the name for the files generated will 
follow this convention: 
 
If the file name is set to PROF the file names generated by ProEx will be 
PROF_nnn_SC (.rad, .rd3, .add) and PROF_nnn_S (.mrk). 
 
nnn is a automatically given number 
S gives the slot the data belongs to, A to H 
C gives the channel, 1 for internal Tx and 2 for external Tx.  
 
The file PROF_0042_B1.rd3 is accordingly radar data from slot B, internal 
Tx.   
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2 Quick start 
_________________________________________________ 
 
This chapter deals with the most essential steps for making, viewing, and 
printing a radar image. Follow the five quick steps below and most of the 
basic functionality of GroundVision is covered. More detailed descriptions 
can be found in Chapter 3 to 5. 
 

2.1 Power ON 
 
First, make sure that the hardware is connected correctly and power is on. 
The circle of the Start F5 button in the tool bar of GroundVision shall be red 
to indicate a correct power on and working communication with the control 
unit (the ProEx or X3M with Ethernet).  

    
If the circle is not red, press the auto-detect key in the toolbar F9, the circle 
shall become red within 5 seconds otherwise a communication failure, 
incorrect cable connections or power failure has occurred. 
 

2.2 Select Measurement Settings 
 
Chose Measurement Settings 
under in the Measure menu or 
right-click on the channel to use in 
the Channel navigator to access 
the measurement settings dialog. 
Here the desired filename, 
directory, antenna and trigger can 
be chosen.  
 
Detailed data collection settings are 
found in the Antenna Settings 
dialog opened by pressing the 
Antenna Settings button.  
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2.3 Start and stop a measurement 
 
Click on the start button on the toolbar, press F5 on the keyboard or select 
Start from the Measure menu to start a measurement with the selected 
settings. To stop the measurement, click on the stop button, press F6 or 
select Stop from the Measure menu.  
 
In distance triggering mode a new trace is collected every time the wheel 
or hip-chain has moved a distance interval as set in the Antenna Settings 
dialog. Time triggering mode works in the same way, using the elapsed 
time and the time interval to determine when to collect a new trace. In 
keyboard triggering mode one trace is collected every time the Enter button 
on the keyboard is pressed. 
 

2.4 View a measured file 
 
To open a file, choose Open (Ctrl 
O) under File in the menu or click 
the Open file button in the toolbar. 
This displays an ordinary Windows 
"open file dialog" in which the user 
specifies the file to open. 

 
When a file is opened the horizontal scrolling position is zero, i.e. the first 
trace are shown to the left in the radargram. Likewise the vertical scrolling 
position is also zero, i.e. the first samples are shown in the top of the 
radargram. Use the windows scrollbars or the arrow keys to navigate 
through the radargram. 
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2.5 Apply filters 
 
Start by choosing Filter Manager 
under View in the menu or right click 
in the radargram and choose Edit 
Filter List or press the F key. This 
activates the Filter Manager. To the 
left, there is a list of available filters 
and to the right the list of the applied 
filters is shown. 

 
The functionality of the Filter Manager is quite straightforward. Choose a 
filter and click either the Add or the Remove button and the chosen filter 
will be either removed or applied. It is also possible to double click the filter 
to be added. By “drag and drop” the order of the filters in the Applied list 
can be altered without removing and applying. The most common filters to 
use are DC Filter and Time Gain Filter. 

The filters applied can be turned OFF and ON by pressing  in the 
toolbar. 
 

2.6 Change the palette 
 
Start by choosing Palette Manager under View in the menu or right click in 
the radargram and choose Change Palette in the popup menu or press the 
P key. This activates the “Palette Manager”.  
 
Double clicking on a specific "color box" opens a Windows color dialog and 
a new color can be chosen. One single right-click on a color box makes it 
activate for interpolating colors (indicated by a red frame around the colour 
box). Another single right-click on the same color box deactivates it. When 
interpolating the palette it’s recalculated depending on the colors in the 
active color boxes. OK closes the “Palette Manager” and applies the 
palette to the radargram. 
 
Note! On start-up, GroundVision loads the previous used palette 
automatically. 
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2.7 Use Contrast 
 
The Contrast Control is found in the View 
meny, the Toolbar or by pressing F8, and 
it is used to increase the contrast of the 
different radargram views. The effect of changing the contrast is, 
somewhat similar to a change in the gain function, but much easier and 
faster to do. 
 

2.8 Print 
 
To print a radargram click on the Print button in the toolbar or chose Print 
in the File menu. A standard Windows print dialog will appear in which the 
printer to use and pages can be altered. The default settings are the same 
as the default print settings for your Windows operating system. Clicking 
OK prints the radargram with the actual settings. The printout can also be 
inspected prior to printout with the Print Preview in the File menu. A Print 
Setup function is also available in the File menu. A standard Windows print 
setup dialog will appear in which the printer, paper, and format can be 
altered. 
 
Note! A windows printer driver must be installed for the Print Preview 
function to work. 
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3 Detailed instructions – Files and 
Measurements 

_________________________________________________ 

3.1 Files and radargrams 
 
The technique used when managing the files and the radargrams in 
GroundVision is very similar to any other Windows program. Every 
radargram opens in its own window, which the user can maximize, 
minimize, and resize using the standard Windows commands. No data is 
changed in the data file (.rd3) when the file is open for viewing. For this 
reason there is no need for saving when the file is closed.  
 

3.1.1 Handle the trace window 
The Trace Window shows a number of panels with a single trace in each. 
There is one panel for every active channel. The position of the mouse 
cursor over the radargram determines which trace is shown. Toggle (turn 
on/off) the trace window by pressing T on the keyboard, clicking the trace 
window button on the toolbar or select Trace Window from the View menu.  
 

3.2 Measuring issues 
 
To start a measurement the communication between the PC and the ProEx 
or X3M has to be functioning. If the button F5 is red the measurement can 
start. Otherwise F9 can be used to connect the PC to the control unit. 
During measurement the F6 button is used to stop a profile. It can be 
started again by pressing F5.  

     
 

Note! If a profile is closed it cannot be restarted again. 

3.2.1 Start a measurement and change the settings 
A measurement is carried out with the following steps: 
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1. Make the correct settings for the antennas used 
2. Start the measurements F5 
3. Stop the measurements F6 
4. If a new profile is started with the same settings, go to 2, otherwise 

1.  
 
The file name is given in the Measurement settings dialog, and also the 
directory where to save it. Observe that the file name will be automatically 
extended according to the convention in Chapter 1.3. Choose the  
correct antenna, acquisition mode measurement wheel (more information 
in Chapter 6.1). 
In order to view or change 
the measurement settings, 
click the Antenna Settings 
button in the Measurement 
settings dialog. See below. 
 
The antenna settings are 
changed for the Slot and 
Channel viewed In the 
example at right Slot A and 
Channel Internal. Note! 
These options are only 
available for the ProEx 
control unit.  

 
 
If the Channel navigator is 
opened (F8 or under the View 
menu) the settings for the 
different antennas connected 
can be changed by first 
marking the antenna to change 
and then by right-click on the 
same and choose the option 
Edit Measurement settings. 
This opens the same settings 
dialog as explained above and 
viewed below  
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If there is something wrong in the 
communication, for instance for the 
transmitter antenna, the trace will 
not be viewed, instead the trace 
window will be black as seen to the 
right. 

 
 
All measurement specific settings can be viewed and manipulated in the 
Antenna settings dialog. The trace view displays a trace measured with the 
actual parameters and is updated for every change. All controls can be 
managed both with the keyboard and the mouse. In the header of the 
dialog the antenna changed are seen as a description of the slot and the 
channel.  
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Adjusting the Sampling Frequency and/or the Number of Samples controls 
the Time Window. 
 
Sampling Frequency shall be set to approximately 10 to 12 times the 
antenna frequency. If the trace view only displays a straight line, make sure 
that the transmitter is turned on and is correctly connected. Does not that 
help; try the Search for Time Zero button. 
 
Number of Samples shall be set to a value near 500 for the best 
performance. A higher number increase the total measured time window 
but slow down the measuring speed and creates larger data files.  
 
Alter the Trig Interval (Point distance) if the default settings are not 
appropriate. Make sure that the Antenna Separation is correct. Otherwise, 
the calculation of the zero for the vertical scale will be incorrect. 
 
The Auto stacking option is enabled by checking the Auto check box to 
the right of the Number of stacks. When automatic stacking is enabled then 
the radar system automatically performs as many stacks as possible for 
each trace. In practice this means that the number of stacks will decrease if 
the antenna is moved faster, and increase if the antenna is moved slower.  
 
If the option Beeper is ticked, a beep will be given for each measurement. 
 
When the 50/60 MHz sensor is active EM data from the HF antennas with 
EM option will be collected. See also Operating Manual för HF antennas.  
 
In active mode, when the ProEx or X3M with Ethernet connection and 
GroundVision are collecting data the radargram screen is yellow; otherwise 
the radargram window is white. An example of GroundVision for ProEx in 
active mode is shown below.  
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When using several antennas only one radargram is shown at the time. To 
select which data to show just click on the channel you want to activate in 
the Channel navigator (F7), right-click and choose Toggle active.  
 
In the main menu the position is of the profile is viewed, together with the 
workload indicator. This should not go up to red more than occasionally, to 
give data of good quality. 
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3.2.2 Edit the measurement information 
There are two ways to bring up the 
Measurement Information dialog. 
Either when a new measurement 
is started or by selecting 
Measurement Information under 
View in the menu. 
 
Only the white areas allow 
typing/editing. When desired 
editing has been made OK saves 
the new information in the header 
file (.rad). 

 
 
Note! Never open the header file in any word processor or editor! The file 
might be corrupted. 
 

3.2.3 Define, save, and delete antenna settings 
As changes has been made in the Antenna Settings dialog these are 
immediately saved for that given antenna. To create a new antenna 
setting, open the Edit Antenna list dialog in the Tools menu and press Add. 
The name can freely be given. Then go the Antenna settings menu and do 
the correct settings.  
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3.2.4 Apply filters during measurement 
Filters (see also Appendix 1) can be applied during measurement. 
However, the filter manager is not accessible during measurement. In 
order to add or remove filters or alter the settings of applied filters the user 
must do the following: 
 
1. Stop the measurement (F6). 
2. Apply filters  
3. Restart the measurement (F5). 
 
The data shown in the radargram is now filtered and the incoming data 
during measurement will be filtered before shown on the display. 
 
Note that filtering during measurement increases the workload on the PC. 
The acquisition speed while heavy filtering is applied is much correlated to 
the power of the PC. When the power of the PC is the limiting factor, 
vertical fields without data may occur in the radargram.  
 
Note! Applied filters only affects the view on the display, the raw data 
saved on the computer is always kept unaffected. 

The filters applied can be turned OFF and ON by pressing  in the 
toolbar. 
 

3.2.5 Change the palette when measuring 
The user can define any palette and use it during measurement. The 
palette can be altered when measuring, by right-click on the radargram and 
the choosing Change palette.  
 

3.2.6 50/60 MHz EM sensor data  
When measuring with MALÅ HF antennas with EM option the EM data can 
be viewed by selecting 50/60 MHz sensor data in the View menu. Both 
gradients of the EM sensors are viewed in the same EM window.  
 

The EM data can also be turned ON and OFF with the  in the toolbar.  
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4 Detailed instructions - GPS 
_________________________________________________ 

4.1 GPS Support  
 
GroundVision supports logging of GPS data during measurement. The 
result of such a measurement is a GPS log file (*.cor, *.utm or *.lcf, see File 
Format below) in which GPS data are written together with the 
corresponding trace number. GroundVision can read GPS data from any 
GPS receiver that supports output of data with the NMEA or TSIP 
communication protocols. The GPS receiver should be connected to the 
serial port of the laptop. In order to make the GPS Manager visible chose 
GPS Manager under View in the main menu. This menu alternative toggles 
the GPS Manager On/Off. 
 
When first shown the GPS 
manager window (found under 
the view menu) gives access 
to basic options only. To 
access the advanced options 
just press the Advanced 
button. Pressing it again will 
close the Advanced section of 
the dialog. 

 

 
Note! See also Appendix 2 for more information on measurements with 
GPS.  

4.1.1 Basic options 
Connect to GPS 
Press this button to activate the communication with the GPS receiver. If 
there is no contact make sure that the communications settings (see 
below) match those of the GPS receiver. When this button is activated the 
GroundVision software will create a *.cor-file for each radar file produced 

and  is viewed on the main menu, 
giving the GPS-position.  
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Interpolate positions 
Due to the low position update rate of many GPS receivers there are often 
several traces with exactly the same position in the GPS data file created 
by GroundVision. When the Interpolate positions checkbox is checked this 
stair cased appearance is removed by interpolating between positions in 
the data file. This procedure will give best results if the radar unit is moved 
with constant velocity.  
 
Output file format 
Use this selection box to choose between the four different position output 
formats supported by GroundVision: GroundVision Standard (*.cor), 
WSKTRANS (*.fri), UTM coordinates (*.utm) and Local coordinates (*.lcf).  
The option Local coordinates supports GPS systems that directly can send 
transformed coordinates (with an extended NMEA-protocol).   
 

4.1.2 Advanced options 
The advanced options are all communications settings. Normally the 
default settings should work but if there is no contact with the GPS receiver 
use these options to make sure that the communications settings match 
those of the receiver. 
 
Baud rate, Parity, Data bits, and Stop bits  
These are serial port communication settings, which must match those of 
the GPS receiver. 
 
Com. Port 
This setting determines witch serial port on the computer to use for the 
GPS receiver. The default selection is the first serial port (COM 1). 
 
Protocol  
Selects witch communication protocol to use. NMEA (0183) is a standard 
protocol that should work with most GPS receivers. TSIP is a protocol 
supported by Trimble GPS units. The default selection is NMEA. 
 
Typical settings for the advanced option, for the communication between 
the GPS and GroundVision, are shown below. The GPS used should of 
course also be set according to this and connected to the Com-port on the 
laptop used.   
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4.1.3 Output file formats 
When a new measurement is started a GPS data file is created in the 
same directory as the files containing GPR data. The file name of the GPS 
data file is the same as for the GPR data with a different file extension. 
During measurement the GPS data file is continuously updated to minimize 
data loss in occasion of a crash. A GPS data file is created for each slot 
when measuring with the ProEx control unit.  
 
GroundVision Standard 
This data file format contains the following information: trace number, date, 
latitude, longitude, height above mean sea level, and HDOP. HDOP is a 
theoretical measure of the accuracy in the horizontal coordinates based on 
the positions of the available GPS satellites. A lower value indicates better 
accuracy. The date and time is expressed in Greenwich time zone. The 
following is an excerpt of a *.cor file (Trace# date time latitude N longitude 
E “height above MSL” M HDOP): 
 
105  2000-9-13  11:9:33  65.18164955141  N  18.75051193218  W  357.26  M  1.454542 
106  2000-9-13  11:9:34  65.18164955141  N  18.75051193218  W  357.26  M  1.454657 
107  2000-9-13  11:9:35  65.18164955141  N  18.75051193218  W  357.26  M  1.454898 
 
EU89-Geodetisk,P,G,HE 
“Trace #” latitude longitude “height above ellipsoid” 
 
UTM-coordinates 
This file format contains coordinates in the global UTM system. The 
coordinates are calculated from the GPS data using Redfearn’s formulas 
on the WGS84 ellipsoid. The file format is defined as: 
 
“Trace #”   northing   easting   “height above MSL”  “UTM zone” 
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5 Detailed instructions – Markers, 
Filtering, Palette 

_________________________________________________ 

5.1 Markers  
GroundVision supports a multiple marker function during measurement. Up 
to 9 markers of different type and colour can be configured in the marker 
dialog.  
 
The Markers configuration dialog is opened 
from the Tools menu in the main window. All 
the boxes in this window will be empty the 
first time GroundVision is started. The 9 
numerical keys 1-9 on the keyboard are 
predefined as marker keys. Each key needs 
to be enabled by checking the white box to 
the right of each key number. A new colour 
can be selected by a double click on the 
colour box. Any comment for each marker 
type can be entered in the comments field. 
 
A new marker file with the extension *.mkn is 
generated if any marker keys are pressed 
during measurement. The marker file is a 
text file.  
 
The first lines contain information about the header version. Following in 
the file there is four columns (should be tab-separated) with trace number, 
sample number, marker type and marker label.  
 

5.2 Filtering 
 
To be able to apply filters at least one file must be open. The filter 
commands are only valid for the active radargram. Much of the functionality 
described in the topics below is for mouse usage. However, the keyboard 
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can be used in many of these cases. Use the Tab on the keyboard to move 
the input focus between functions and press the Spacebar instead of 
clicking the mouse. 
 

5.2.1 Apply and remove filters 
Start by choosing Filter Manager 
under View in the menu or right click 
in the radargram and choose Filter 
in the popup menu. This activates 
the Filter Manager. To the left, there 
is a list of available filters and to the 
right; there is a list of the applied 
filters. 
 

 
 
The functionality of the Filter Manager is quite straightforward. Choose a 
filter and click either the Add or the Remove button and the chosen filter 
will be either removed or applied. You can also apply a filter by pressing 
the space key and remove a filter by pressing the Alt+R or Del, or you can 
both apply and remove by holding down the mouse button and dragging 
the filter to the list of available filters. By “drag and drop function” the order 
of the filters in the applied list can be altered without removing and 
applying. 
 
When a filter is being applied, a 
filter-settings dialog appears. Each 
type of filter has its own settings 
dialog with the specific parameters. 
The trace window is common to all 
filter settings dialogs. It displays the 
trace chosen with the Trace Control 
with filters applied, including the 
previous filters from the applied list. 
 

 
Double clicking on a filter in the applied list brings up the filter's settings 
dialog where the filter parameters can be altered.  
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There is an option to disable all filters. To do this, press the shortcut Ctrl+F 

or press  in the toolbar. 
 

5.2.2 Decide what filter to use 
There is no simple answer to that question. A filter very useful for some 
applications can be useless in others. Depending on the application and 
the quality of the radar image a range of different filters can be applied. 
The knowledge and experience of the user often determines the time it 
takes to produce a useful image. A general recommendation is to start with 
DC Filter and Time Gain Filter, after that perhaps a frequency filter or 
background removal filter is needed. A detailed description of the filters is 
found in Appendix 1. 
 

5.3 Palette issues 
 
To be able to view, alter, load, and save the palette at least one file must 
be open. The palette commands are only valid for the active radargram.  
 

5.3.1 Change the palette 
Start by choosing Palette Manager under View in 
the menu or right click in the radargram and choose 
Palette in the popup menu. This activates the 
Palette Manager. The palette has 30 colors. 
 
Double clicking on a specific "colour box" opens a 
Windows colour dialog and a new colour can be 
chosen. 
 
One single right-click on a "colour box" makes it 
activated, which means that it will be used when 
interpolating the palette. Another single right-click 
on the same "colour box" deactivates it. When interpolating the palette is 
recalculated depending on the colours in the activated "colour boxes". OK 
closes the Palette Manager and applies the new palette to the radargram. 
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5.3.2 Save a palette 
To save a palette click the Save Palette button and a standard Windows 
save dialog will appear. Choose directory in which the palette is to be 
saved, type in a file name, and click the OK button. The palette will now be 
saved in the specified directory with the file extension ".pal". 

5.3.3 Load a palette 
To open a saved palette click the Open Palette button and a standard 
Windows open dialog will appear. Select the palette file to be opened and 
click the OK button. The palette is now loaded into the Palette Manager. 
 

5.4 Scales 
 
To be able to view and alter the scale settings at least one file must be 
open. The scale settings are only valid for the active radargram.  
 
In the Tools menu, 
Options is found. Here the 
vertical scale can be set 
to Time or Depth together 
with the first arrival and 
the velocity to use.  

 

5.4.1 Adjust for first arrival travel time 
Due to antenna separation, the wave travelling from the transmitter directly 
to the receiver (the direct wave) is received some time after the actual 
transmission. This means that the transmitted pulse has already 
penetrated the medium a certain distance before the direct wave is 
received. The result of this is that the depth scale zero must be corrected 
to be accurate.  
 
The zero for the depth scale is calculated using the first arrival value, the 
antenna separation, and the first arrival adjustment velocity. The 
adjustment velocity can be set to any value. Practically however, it can be 
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the ground velocity, the air velocity, or anything in between depending on 
the antenna configuration. 
 

5.5 Printing 

5.5.1 Print a radargram 
To print a radargram click on the Print button in the toolbar or chose Print 
in File menu. A standard Windows print dialog will appear in which the 
printer to use and pages can be altered. The default settings are the same 
as the default print settings for your Windows operating system. Clicking 
OK prints the radargram with the actual settings. 

5.5.2 Choose the printer 
There are two ways of changing the printer. If the printer is to be changed 
just for the actual printing job it can be done in the Windows print dialog 
that appear when printing (see 5.5.1). If one wants to print several 
radargrams on a printer other than the default, that printer can be chosen 
as default (see 5.5.3). 

5.5.3 Alter the printer settings 
To alter the default printer settings in Ground Vision chose Print Setup in 
the File menu. A standard Windows print setup dialog will appear in which 
the printer, paper, and format can be altered. Clicking OK makes the 
settings default for future print jobs. Note that these settings are not saved 
and will not be the same if restarting Ground Vision. 

5.5.4 Use the print preview 
The print preview functionality is similar to Microsoft Word. Chose Print 
Preview in the File menu and the radargram will be displayed as if it were 
to be printed. The print preview uses the default printer settings. To change 
the appearance of the radargram in the print preview mode, change the 
default printer settings (see 5.5.3). When done viewing the radargram in 
print preview mode, click on the Close button. 
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6 System settings 
_______________________________________________________ 

6.1 Perform a wheel calibration 
 
Start with connecting the control unit 
and the wheel to calibrate, switch 
the control unit on. Choose Edit 
Wheel List under Tools menu and 
the Wheel Calibration List dialog will 
appear. Press new. 
 
Observe that in this dialog, the 
option of deleting wheel calibrations 
is also found. Mark the wheel name 
and press Delete.  
 

 
 
Type the desired name of the calibration in the Name edit box and choose 
the correct wheel source to use, Master, Slot A, B, C or D. Give the correct 
distance for the calibration, and press START. When the distance is 
travelled press STOP and the option OK saves the new wheel calibration in 
the control unit memory. 
 
Note! The precision of the encoder wheel is not infinite and depending on 
several factors as; the measurement surface, the pressure applied on the 
wheel and possible wear. If you are unsure of the encoder wheel precision 
a re-calibration should be made.   
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6.2 Choose Measurement Units 
Choose Options under Tools and 
the Options dialog will appear. 
Select the unit you wish to use 
and then press the OK button to 
confirm 

 
. 

6.3 Change Hardware Setup 
The Hardware Setup dialog is 
divided into three areas. The first 
area shows the current version of 
the control unit PROM. If the 
control unit is disabled or 
communication doesn’t work, the 
PROM version will be shown as 
”No control unit detected”. 
  
The second area is for general settings with three checkboxes. The first is 
for enable or disable the audio device on the ProEx. If it is enabled, the 
control unit will give an audio signal at each measured trace. The second 
enables the Skip missed traces mode- In this mode the ProEX will skip 
traces when over-speeding the system. This means that the position of 
each trace is correct but that there may be empty traces in the data set. 
 
The third checkbox enables or disables a kill switch function when using 
the High Frequency antennas (1.2 and 1.6 GHz, US models only). If it is 
enabled measurements can only be carried out if the kill switch button on 
the antenna is pressed down. The measurements will continue for 8 
seconds when the button is released, and the stop. More information is 
found in the Operating Manual for the High frequency antennas.  
 
The third group in the Hardware Setup is the communication settings on 
how communication is performed between the PC and the control unit. In 
the Ethernet interface drop-down-menu the available Ethernet-interfaces 
are seen. The communication between the PC and the ProEx or the X3M 
control unit will work only with Ethernet on wire.  
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7 Trouble shooting 
_________________________________________________ 

7.1 Wheel calibration 
 
- "The wheel calibration list is full! Remove wheel calibrations 

before adding another." The control unit memory is limited. If the 
area dedicated for wheel calibrations is full this error message occur. 
Remove unused wheel calibration and try again. 

- "Wheel calibration distance is too short." In order to make a proper 
wheel calibration a quite large distance should be used. Redo the 
calibration over a longer distance. 
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 Appendix 1 Filters 
_________________________________________________ 
 
 
This appendix covers the 
available filters in the Ground 
Vision filter manager. The filters 
that have settings that need to 
be set have a dialog connected 
to them. This dialog can be 
called from the Filter Manager 
and is shown in each filter 
description. Common to all filter 
dialogs is the trace window that 
shows the filtered trace. The 
trace window is updated when 
there is a change in the filter 
settings.  

 

 
Which filter to use is depending on the application and the quality of the 
radar image. A filter very useful for some applications can be useless in 
others. The knowledge and experience of the user often determines the 
time it takes to produce a useful image. A general recommendation is to 
start with DC filter and Gain. Below the available filters are listed and also if 
they are always, often, seldom or very seldom used in common GPR 
applications.   
 
Always used: DC-shift 
 
Often used: Delete Mean Trace, FIR, Time Gain  
 
Seldom used: Custom Gain, Moving Average, Moving Median, Threshold 
 
Very seldom used: Average, Median, AGC, Triangular FIR, HFIR 
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Automatic gain control AGC 
This filter attempts to adjust the gain of 
each trace by equalizing the mean 
amplitudes observed in a sliding time 
window. A short window gives a more 
pronounced effect, the extreme of 
which would a one-sample window, 
which would cause all amplitudes to be 
equal. The other extreme would be a 
time window of the same length as the 
trace. This would have no effect on the 
trace. After equalization a constant 
multiplier is applied to the trace to 
make the resulting amplitudes 
reasonable.  
  
 
 
Average 
The Average filter calculates a mean 
over a given number of samples and 
traces. The sample in the middle of the 
grid is replaced by the average value. . 
This filter acts as a simple 2D-lowpass 
filter and gives a softer picture. 
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Custom Gain  
An amplifying filter where the 
gain factor is given manually 
for 32 different sections of 
the trace.  
 

 
 
 
DC-Filter 
There is often a constant offset in the 
amplitude of the registered trace, this is 
known as the DC level or the DC offset. 
This filter removes the DC component 
from the data. The DC component is 
individually calculated and removed for 
each trace. 
 
In the dialog the sample interval on 
which the DC component is calculated 
is specified. Values for the start and 
end samples can be entered in the edit 
boxes or by click-dragging in the trace 
view. The sample interval is shown as a 
red area in the trace view. 

 
 

www.malags.com 
34



Delete mean trace 
This filter is used to remove horizontal 
and nearly horizontal features in the 
radargram by subtracting a calculated 
mean trace from all traces, sample by 
sample. The mean trace can be 
calculated for the whole profile or for a 
specified section of the profile. 

 
FIR 
A quick band-pass filter, working with a 
combination of two boxcar (averaging) filters. 
The filter is run in two stages. First the lower 
frequencies are attenuated by  subtracting 
the average in the longer boxcar from the 
raw data at the centre of the boxcar. Then 
the higher frequencies are attenuated by 
replacing each sample with the average 
calculated in the shorter boxcar.  
 
Both boxes calculate along the whole trace.   

 
 
HFIR 
The HFIR filter functions as the FIR 
filter, but the filter runs along the profile - 
not along the trace. The filter is a spatial 
band-pass filter and its effect is similar 
to that of the background removal filter 
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Median 
The Median filter functions as the 
Average filter, but instead of the mean 
value a median value is used. It removes 
spikes in the data efficiently while not 
blurring the image quite as much as the 
average filter does.  
  
 
 

 
 
Moving average 
This filter takes the average as calculated 
by the average filter described above and 
subtracts it from the sample at the centre 
of the filter. Its effect is that of a simple 
2D high-pass filter. 
 
 
Moving median 
As the Moving average filter, but with the 
median value instead of the average.  
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Threshold 
All samples with a value below the 
threshold are set to zero.  
 
 

 
Time-Gain Filter 
The Time-Gain filter applies a time-
varying gain to compensate for 
amplitude loss due to spreading and 
attenuation. The trace is multiplied by a 
gain function combining linear and an 
exponential gain, with coefficients set 
by the user. In the Time-Gain dialog, 
there is one trace window and one gain 
window. The trace window shows a 
filtered trace and the gain window 
shows the gain function applied.   
 The red line in the trace window indicates the start of the filter (before this 
point the gain of the filter is unity). 
 
Triangular FIR  
The Triangular FIR filter functions as 
the FIR filter, but instead of using 
boxcar averages it uses averages in 
symmetrical triangular windows.  
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Appendix 2 GPS measurements 
___________________________________________________________ 
 
This appendix covers some important issues when using a GPS to position 
the GPR measurements.  
 
The Malå Geoscience Monitor or GroundVision software can be used 
together with GPS equipment which communicates via a 9-pin series 
connector. The GPS must communicate with NMEA 0183 protocol with 
GGA sentence. For the Monitor there is also one type of USB GPS 
available, see the Operating Manual Monitor.  
 
The GPS equipment available today can be divided into three different 
types: 
 
GPS: Relatively inexpensive, the GPS is using only satellites for 
positioning, accuracy around ± 4 m. Suitable for large scaled layer 
mapping etc. 
 
DGPS: Differential GPS, uses satellites and a correction from a reference 
station, accuracy around ± 0.5 m. Similar systems are EGNOS (Europe), 
WAAS (USA) and MSAS (Japan). 
 
RTK GPS: Real Time Kinematic GPS, expensive, uses two GPS receivers 
(one stationary base and one rover) and correction signal from the base 
antenna, accuracy around ± 1 cm. Network RTK also available in many 
locations, where the correction is received via GSM. RTK GPS accuracy is 
recommended for utility mapping. 
 
For all the three different GPS systems the following is very important to 
remember:  
 
1) Regardless the system used; GPS, DGPS or RTK, the positioning data 
gathered will be of bad quality if the measurements are made under 
bridges, in dense forest, close to high buildings etc. In the example below 
the lowermost line is measured 1 m from a building, resulting in incorrect 
positioning of that measurement line.  
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2) When using a GPS in motion, the GPS system is updated more or less 
seldom. Inexpensive systems may update 1 time/second while RTK 
systems can update 10 or more times/second which of course can effect 
the end result.  
 
3) The GPS antenna should be placed on the middle of the GPR antenna 
(on the measurement point) to give the most correct position of the GPR 
traces. This will be a problem when measuring with the MALÅ Geoscience 
RT antennas, and should be corrected afterwards, or if the GPS is located 
elsewhere. 
 

 
 
4) It should be observed that during the day the connection to satellites can 
change, giving better or worse positioning possibilities.  

www.malags.com 
39



 Corporate Headquarters  Offices

MALÅ Geoscience AB
Skolgatan 11, SE-930 70 
Malå, Sweden
Phone: +46 953 345 50 
Fax: +46 953 345 67
E-mail: sales@malags.com

USA: 

China:

MALÅ Geoscience USA, Inc., 465 Deanna Lane, Charleston, SC 29492 
Phone: +1 843 852 5021, Fax: +1 843 284 0684, E-mail: sales.usa@malags.com

MALÅ GeoScience (China), Room 2604, Yuan Chen Xin BLDG, No.12 Yu Min Road 
Chao Yang District, Beijing 100029 
Phone: +86 108 225 0728, Fax: +86 108 225 0815, E-mail: sales@malags.com

www.malags.com

MALÅ products are under continuous development and we reserve the right to alter or amend any published information or specification without notice. 
Copyright 2011 MALÅ Geoscience AB. All r ights reserved.


	1 Introduction
	1.1 Installation and Communication
	1.2 User interface
	1.2.1 Main Window
	1.2.2 Workspace
	1.2.3 Menu
	1.2.4 Toolbar
	1.2.5 Radargram
	1.2.6 Trace View

	1.3 File format

	2 Quick start
	2.1 Power ON
	2.2 Select Measurement Settings
	2.3 Start and stop a measurement
	2.4 View a measured file
	2.5 Apply filters
	2.6 Change the palette
	2.7 Use Contrast
	2.8 Print

	3 Detailed instructions – Files and Measurements
	3.1 Files and radargrams
	3.1.1 Handle the trace window

	3.2 Measuring issues
	3.2.1 Start a measurement and change the settings
	3.2.2 Edit the measurement information
	3.2.3 Define, save, and delete antenna settings
	3.2.4 Apply filters during measurement
	3.2.5 Change the palette when measuring
	3.2.6 50/60 MHz EM sensor data 


	4 Detailed instructions - GPS
	4.1 GPS Support 
	4.1.1 Basic options
	4.1.2 Advanced options
	4.1.3 Output file formats


	5 Detailed instructions – Markers, Filtering, Palette
	5.1 Markers 
	5.2 Filtering
	5.2.1 Apply and remove filters
	5.2.2 Decide what filter to use

	5.3 Palette issues
	Change the palette
	5.3.2 Save a palette
	5.3.3 Load a palette

	5.4 Scales
	5.4.1 Adjust for first arrival travel time

	5.5 Printing
	5.5.1 Print a radargram
	5.5.2 Choose the printer
	5.5.3 Alter the printer settings
	5.5.4 Use the print preview


	6 System settings
	6.1 Perform a wheel calibration
	6.2 Choose Measurement Units
	6.3 Change Hardware Setup

	7 Trouble shooting
	7.1 Wheel calibration

	 Appendix 1 Filters
	Appendix 2 GPS measurements



